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Please note: 

All information in this manual has been prepared with great care. The manufacturer of this hardware 
and software, however, does not accept liability for possible errors, changes and/or omissions. Please 
contact your sales partner for an updated copy of this guide. This user manual is for information 
purposes only and aims to support you in tackling the challenges and taking full advantage of all 
opportunities the technology has to offer. Individual applications may not be covered and need 
different handling. Responsibility and testing obligations remain with the luminaire 
manufacturer/OEM/application planner. 
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About Tuner4TRONIC

Purpose and Application

The Tuner4TRONIC (T4T) software suite allows luminaire manufacturers to program LED drivers via DALI and/or NFC in a simple, fast, 
reliable and cost-effective way, speeding up the production process.
Click here to watch a short video that gives a great overview about Tuner4TRONIC.

This software for Windows consists of four different modules according to the environment of use:

 Tuner4TRONIC Development

Luminaire designers can configure LED drivers by setting 
parameters such as output current, dimming levels, constant 
lumen output, operating modes and much more. Thanks to its 
multi-level password system, Configuration Lock protects LED 
drivers against unauthorized changes while service technicians 
can still be granted access rights for selected features. 
Once the configuration has been completed, the settings are 
exported as an encrypted read-only production file and 
transmitted to the production line.

Tuner4TRONIC Production

Factory workers can easily load encrypted production files in 
order to start automatic programming for the fast mass production 
of LED drivers. Changes to the LED driver configuration are not 
possible during this stage. Provides a multilingual user interface.

Files Types

The Tuner4TRONIC Development creates and processes different file types, as follows:

Tuner4TRONIC project file = .osrtul
Tuner4TRONIC production file = .osrtup
ECG description file = .osrtud

Workflow between the different T4T Versions

The luminaire product manager/designer creates his desired configuration (e.g. current, CLO, EL) using T4T Development. He saves his 
project as a *.osrtul file. It is possible to test the configuration by programming individual drivers. When the configuration is finished and 
ready for production, a read-only *.osrtup production file is exported and sent to the assembly line.

At the assembly line, the production file is loaded using T4T Production and the simplified mass programming can start. 
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Installation

System Requirements

The minimum system requirements for T4T are:

A programming interface such as:
OSRAM DALI magic
NFC programmer (FEIG reader)

A PC or Notebook with the following specification
Pentium M processor
1 GB main memory
Windows 7 (both 32 or 64-bit), Window 8 / 8.1 (both 32 or 64-bit) or Windows 10 (both 32 or 64-bit) latest SP installed
100 MB hard disk memory
Monitor with a resolution of 1024x768 pixels, the recommended zoom factor is 100%
one free USB 2.0 port

Software Installation

 Always read the "Release Notes" in the zip file before installing the SW.NOTE:
. The installer MUST have Windows administrator rights

Extract in a folder all files included in the Tuner4TRONIC zip file and then run "Install T4T.exe" available in that folder. By default, both 
Tuner4TRONIC Development and Tuner4TRONIC Production will be installed, but there is the option to select only one of them. 
Tuner4TRONIC Development and Tuner4TRONIC Production can be launched from "Start" => "All Programs" => "Tuner4TRONIC" or by 
double-clicking the desktop icons.
Follow the instruction included in the Tuner4TRONIC zip file in order to use the components T4T-CMD or T4T-DLL or other possible SW 
tools.

Hardware Installation

To program luminaries containing LED drivers, it's needed a programming interface suitable for the used ECG(s):

[1] ECG with DALI interface

(multi and/or single programming)

DALI magic
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[2] ECG with NFC interface 
(only single programming)

FEIG PRH101 

 

FEIG CPR30

FEIG MR102

Tuner4TRONIC is capable to handle more than one programming interface connected to the same PC (see Programming interfaces 
chapter)

ECG with DALI interface:

Step Activity

1 Connect DALI magic and PC with the enclosed USB cable.

(2) Connect the external 6V DC power supply to the DALI magic. 
The use of an external power supply is mandatory in case of more 
than 4 ECGs connected to the DALI line, anyhow it is strongly 
recommended to always use the external power supply in order to 
improve the stability of the DALI communication.

3 Connect the DALI  terminals of the DALI magic with the DALI
inputs of the ECG(s).

4 Connect the ECG to mains and PE if the related terminal is 
available in the ECG.

                                                                                            POWER ON THE ECG

NOTE: most of the DALI LED drivers allow programming when supplied with a low voltage (e.g. 48V) instead of the (full) mains 
voltage.
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For further details, please consult the LED driver's datasheets.

ECG with NFC- Interface

Step Activity

1 Connect a Programming Interface FEIG PRH101, FEIG CPR30 or 
FEIG MR102 to the PC with the enclosed USB cable.

2 Put the Programming interface close in contact with the NFC area 
of the ECG (see logo) and hold still both ECG and programming 
interface till the process is completed

Important Information:

Keep the ECG powered OFF during programming via NFC - unless otherwise indicated in the ECG documentation.
Keep both Programming interface antenna and ECG with NFC in close contact during the complete programming process.
Switching on/off an ECG with the NFC reader in close proximity may mistakenly terminate the USB connection of the NFC reader's 
drivers, which leads to T4T complaining that no NFC interface is connected. In this case, please re-connect the reader by opening 
the Settings / Programming Interfaces Dialog and selecting it again.
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1.
2.

3.

Compatibility with previous versions of Tuner4TRONIC

IMPORTANT INFORMATION:

.osrtup) generated with the previous versions* Production files ( from 1.x. to 2.1 cannot be used with the Tuner4TRONIC 3.3
anymore.

.osrtup) generated with the previous versions from 2.4 to 3.1 can be opened directly with the Tuner4TRONIC 3.3. Production files (
However, as a different data model is used in v3.3, Tuner4TRONIC will convert the files on-the-fly to v3.3 while keeping the original 
older file unmodified. If you wish to use the file in 3.3 we recommend saving a copy of the file as the new format 3.3.* 

In addition, a conversion utility is available in the Tools menu of Tuner4TRONIC Development: "Upgrade Production Files".

:NOTE before proceeding
It's not possible to downgrade the files from version 3.3 to previous versions. It's strongly recommended to save a backup 
copy of the files before upgrading them.

Procedure to upgrade the files from version 2.4 and 3.1: 11
2

Select "Upgrade Production File(s)" in the Tools menu of T4T Development.
Select the folder containing the T4T-P (.osrtup) files made with T4T-D versions 2.4 or 3.1 and confirm by pressing the "OK" 
button the utility will upgrade all files included in the folder and possible sub-folders.
A confirmation message will display the number of files upgraded.Now the files can be used with T4T-Production version 3.3

User Interface
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Basic Layout

Menu Bar

The basic functions are available via the menu bar. Submenus or dialogs are opened by clicking an entry in the menu bar. The menu 
contains the following elements, each with the listed sub items.

File Menu

New Creates a new Luminaire configuration. By default the loaded 
configuration will not be saved and the default file name will be 
"Untitled.osrtul*".

Creates a new Luminaire configuration loading the parameters 
from the connected Luminaire. By default The loaded 
configuration will not be saved and the default file name will be 
"Untitled.osrtul*".
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New From Production File Creates a new Luminaire configuration loading the parameters 
from a Production file. The loaded configuration will not be saved 
and the default file name will be "Untitled.osrtul*".

Open Loads an existing Luminaire configuration.

Save Changes Saves the current Luminaire configuration.

Save As Saves the current Luminaire configuration under a new name.

Recently Used Files List of the recently used Luminaire configurations

Close Close Tunner4TRONIC.

Tools Menu

Program Configuration Writes the current Luminaire configuration to the connected 
Luminaire

Generate Luminaire Production File Creates the Luminaire Production File for the Tuner4TRONIC 
Production; the file extension is: .osrtup

Upgrade production file(s) Makes T4T-P files (.osrtup) of versions 1.x usable with T4T-P 
version 2.4 or higher.

Compare configuration(s) Compare actual configuration with the connected luminaire

Copy Feature(s) from File Copy into actual configuration a feature of a saved project

Add new ECG(s) Load a previously saved ECG configuration file

Settings Menu

Programming Interface Visualize, the connected programming interface(s) and enables 
the selection of the default one (for each types) to be used only 
for programming. For reading luminaire's configurations the user 
has to select the programming interface every time if more than 
one is available.

About Menu

Help Shows Tuner4TRONIC User Manual

Info Opens the Info dialog

Updates
disable Automatic Updates, Check for updates manually, 
download Tuner4Tronic installer and configure the path to 
download Tuner4Tronic installer.

Toolbar
The toolbar provides instant access to the most important actions.

New Creates a new Luminaire configuration. By 
default the loaded configuration will not be 
saved and the default file name will be 
"Untitled.osrtul*".
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New From Luminaire Creates a new Luminaire configuration 
loading the parameters from the 
connected Luminaire. By default the 
loaded configuration will not be saved and 
the default file name will be "Untitled.
osrtul*".

Open Loads an existing Luminaire configuration.

Save Saves the current Luminaire configuration.

Save As Saves the current Luminaire configuration 
with a new name.

Compare Configuration(s) Compare actual configuration with the 
connected luminaire.

Copy Feature(s) from File Copy into actual configuration a feature of 
a saved project

Program Configuration Writes the current Luminaire configuration 
to the connected Luminaire

Generate Luminaire Production File Creates the Luminaire Production File for 
the Tuner4TRONIC Production; the file 
extension is: .osrtup
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Workspaces

Luminaire Area

ECG Tab Control

Features Tab Control
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The Features list contains only the features supported by the selected ECG.
Always refer to the ECG's technical documentation for the supported features.

 NOTE: unselecting a feature from programming does not mean  it.
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Feature Area

Parameter Groups
The parameters of the feature are collected into Parameter Groups. 

Feature Selection State
This symbol is displayed only in case the feature is not selected to be programmed (through the check box in the feature tab). 

Chart
Displays in a graphical way the values input in the parameters (optionally available).

Status and Progress Bar

It displays the progress of the currently executed task, like read/program luminaire.
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General Operation

Create a new Luminaire Configuration

Scope: create a new project starting from factory new ECGs.

Step Activity

1

 button 
in the toolbar. 

NOTE: this window is always accessible using the Luminaire info 

button

2 Set luminaire image (optional).

3 Fill Luminaire information.

4 Config ID-Enter a ConfigID to be programmed to the device.
Config ID checkbox-Option to select whether the ConfigID is to be 
programed or not. 
If the Config ID is not selected for programming then Config ID 
text box will be hidden. 

5
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Select ECG(s) using the buttons:  or 

Remove possible unwanted ECG using the button 
NOTE: a luminaire could contain more than one ECG; up to two 
different types are allowed and the multiplicity of each type 
depends on the used programming interface (so far only multiple 
DALI ECGs are allowed up to 64 in total)

6 Click OK button to create the project. This button is active only if 
all the mandatory information was entered correctly. 
The project will not be saved on Click of OK button and the 
default file name will be "Untitled*".

7 If the luminaire has a Config ID, the default luminaire name will be 
the "luminaire name-Config ID".

LED drivers list (  )

LED drivers are listed according to the Programming Interface and ECG types and also Search text. It's possible to define preferred ECG(s) 
in order to speed up the selection of the most used ones. 
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Create new Luminaire Configuration from Luminaire

Scope: create a new project by reading the whole configuration of the connected luminaire.

Step Activity

1 Select from the Settings menu which programming interface has 
to be used to readout the luminaire, in case more than one is 
connected to the PC. Please confirm by pressing "OK" button. 

2

Click "New from Luminaire"  in the toolbar or in the File 
menu.

3 On successful read, a dialog will display the following information.

Device connected with Device type name
The time taken to read from the device.
The encrypted OEM key, if the ECG is password protected
The Lamp operating time, if the feature is supported in the 
ECG.

On click of "Yes", the Main window shall be loaded with all 
features and the file will be named "Untitled.osrtul*" else will 
remain in the same screen.A production file cannot be 
generated if the configuration is not saved.

4 Continue as described in previous "Create new Luminaire 
Configuration" paragraph on click of Save or Save As.

Open a Luminaire Configuration

Step Activity

1

Click "Open"  in the toolbar or in the File menu.

2 Select the proper file with extension .osrtul.

3 Open the configuration by double-clicking. 
The name of the loaded configuration appears in the header of 
the Tuner4TRONIC.
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Add ECG(s)Scope: add new EGC to the list without the need to reinstall the whole SW.

Step Activity

1 Click "Add new ECG(S)" in the in the Tools menu.

2 Select the proper file with extension .osrtud.

3 Open the file by double-clicking. 
When loaded the ECG will appear on the ECG list

Setting the Programming Interface

Scope: This dialog shows all current connected ECG programmer to the PC and allows each type to define the default one for programming.
Go to the Settings menu and select Programming Interfaces.

Click on the pencil icon  to change the name of the programming interface (only for DALI magic), then press "enter" key on the 
keyboard.
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1.

2.

1.

2.

3.

Programming a Luminaire

Scope: Lab test of the luminaire; write configuration into the luminaire, for the engineering purposes without generating the production file 
and without using the Tuner4TRONIC Production.

Step Activity

1

Click "Program configuration"  in the toolbar or in the 
Tools menu. 

2 Set Luminaire Lock Status

 The Luminaire has no Configuration Lock Unprotected.
Master Key or OEM key set.

 The Luminaire is locked thus it is needed to Protected.
unlock it before proceeding with the programming: 

 Use this option if the code needed Use Key form file.
to unlock equals the one set in the Configuration Lock 
or OEM Key feature.

 Input in the field the code to unlock Key __ __ __ __ .
(which can be different from the one in the 
Configuration Lock or OEM Key feature). If the 
Configuration Lock or OEM Key feature is selected, 
after programming, the Luminaire will be locked using 
the code of the Configuration Lock or OEM Key 
feature. 
 
Important Information about the protection of 
luminaire configurations
We strongly advise to set a password to avoid 
unintentional or unauthorized adjustment of crucial 
parameters that might lead to damage or non-safe 
operation of a luminaire. Please also consider the 
required luminaire certifications and the effect of 
parameter adjustments on the validity of such 
certifications.

3 Other settings:

: select this option if the Single Luminaire only
programming station processes only one luminaire at a 
time, this will speed up the programming (less time to 
detect the luminaire).

: select this option if the Multiple Luminaires
programming station processes more than one DALI 
luminaire at a time (automatic sequential programming); 
DALI addressing is performed before programming, then 
after programming is completed all short addresses are 
cleared.These two previous settings are only available for 
devices with DALI terminals only.

 after Verify parameters after programming:
programming  the configuration is read back and ,
compared with the one just programmed. This slow down 
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4.

the overall programming speed. This option is not 
available in case a NFC Reader is selected as the 
programming interface.
Disable Family Programming
The term "Family Programming" refers to the capability of 
T4T to be able to program LED drivers within the same or 
later generation of one product family using the same 
production file, thus simplifying the production workflow. 
A product family is defined as a group of related LED 
driver models of the same target application and similar 
physical characteristics, but can differ in the name, 
firmware version, current and/or power. Generations 
typically differ in the set of included features.

Family Programming will fail when the capability of the 
target driver are not sufficient for the configuration 
defined in the production file. For example, if a driver 
supports only 1A, but the original configuration has 
selected 1,2A then the program must (and will) fail.

Moreover, Family Programming only works forward (e.g. 
from a G2 device to a G3 device), not backward (e.g. 
from a G2 device to a G1 device). The reason is  that 
later generations introduce new features that may not be 
available in the older generation. Therefore the usage of 
a production file created for a newer generation for 
programming of an old driver is not possible.

When devices of different generations are mixed in the 
production, the recommended usage is to create a 
projects / production files based on the older devices of a 
family. When newer features shall be used, a new 
production file has to be created and only the newer 
drivers can be used.  

Family programming was introduced to Tuner4TRONIC 
in version 3.3. 
By default, family programming is turned on. Turning off 
this option means that T4T will only program the exactly 
specified driver model (i.e. only drivers with the same 
name and firmware version will be programmed).

In T4T-Development the Family Programming can be 
disabled during creation of the Production file in the 
Programming Setup:

A list of all supported and unsupported drivers of family 
programming is provided at the  of this document.Appendix 1

4 Click OK to move to the programming dialog. 
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1.

2.

Create the Luminaire Production File

Scope: ready for mass production; provide the shop floor with the configuration file (.osrtup) to be programmed into the luminaires by 
operators using Tuner4TRONIC Production, or using a third party SW based on T4T-DLL or T4T-CMD (see related user manuals for further 
details) .

Step Activity

1

menu bar select the  button in the main toolbar. 

2 Luminaire
Fill in the Luminaire information here (name is mandatory), 
including an image. This info will be available in the reports and 
also displayed in the operator's mask of Tuner4TRONIC 
Production to help the programming activity (visual aid).

3 Set Luminaire Lock Status

 The Luminaire has no Configuration Lock Unprotected.
Master Key or OEM key set.

 The Luminaire is locked thus it is needed to Protected.
unlock it before proceeding with the programming: 

 Use this option if the code needed Use Key form file.
to unlock equals the one set in the Configuration Lock 
or OEM Key feature.

 Input in the field the code to unlock Key __ __ __ __ .
(which can be different from the one in the 
Configuration Lock or OEM Key feature). If the 
Configuration Lock or OEM Key feature is selected, 
after programming, the Luminaire will be locked using 
the code of the Configuration Lock or OEM Key 
feature. 
 
Important Information about the protection of 
luminaire configurations
We strongly advise to set a password to avoid 
unintentional or unauthorized adjustment of crucial 
parameters that might lead to damage or non-safe 
operation of a luminaire. Please also consider the 
required luminaire certifications and the effect of 
parameter adjustments on the validity of such 
certifications.

4 Other settings:
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1.

2.

3.

4.

: select this option if the Single Luminaire only
programming station processes only one luminaire at a 
time, this will speed up the programming (less time to 
detect the luminaire).

: select this option if the Multiple Luminaires
programming station processes more than one DALI 
luminaire at a time (automatic sequential programming); 
DALI addressing is performed before programming, then 
after programming is completed all short addresses are 
cleared.These two previous settings are only available for 
devices with DALI terminals only.

 after Verify parameters after programming:
programming  the configuration is read back and ,
compared with the one just programmed. This slow down 
the overall programming speed. This option is not 
available in case a NFC Reader is selected as the 
programming interface.

 The term "Family Disable Family Programming
Programming" refers to the capability of T4T to be able to 
program LED drivers within the same or later generation 
of one product family using the same production file, thus 
simplifying the production workflow. A product family is 
defined as a group of related LED driver models of the 
same target application and similar physical 
characteristics, but can differ in the name, firmware 
version, current and/or power. Generations typically differ 
in the set of included features.

Family Programming will fail when the capability of the 
target driver are not sufficient for the configuration 
defined in the production file. For example, if a driver 
supports only 1A, but the original configuration has 
selected 1,2A then the program must (and will) fail.

Moreover, Family Programming only works forward (e.g. 
from a G2 device to a G3 device), not backward (e.g. 
from a G2 device to a G1 device). The reason is  that 
later generations introduce new features that may not be 
available in the older generation. Therefore the usage of 
a production file created for a newer generation for 
programming of an old driver is not possible.

When devices of different generations are mixed in the 
production, the recommended usage is to create a 
projects / production files based on the older devices of a 
family. When newer features shall be used, a new 
production file has to be created and only the newer 
drivers can be used.  

Family programming was introduced to Tuner4TRONIC 
in version 3.3. 
By default, family programming is turned on. Turning off 
this option means that T4T will only program the exactly 
specified driver model (i.e. only drivers with the same 
name and firmware version will be programmed).

In T4T-Development the Family Programming can be 
disabled during creation of the Production file in the 
Programming Setup:

A list of all supported and unsupported drivers of family 
programming is provided at the  of this document.Appendix 1

5 When completed, click "OK" button to proceed: select folder for 
saving the file and click on "SAVE" button.
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Select/Unselect a Feature for Programming

Step Activity

1 Selected Feature.

The selected features will be programmed with the settings on 
screen.
NOTE:

at least one feature shall be selected in order to be able to 
create a Luminaire Production File,
some features can be selected / unselected only together with 
others because of restrictions which varies according to the 
ECG type.

2 Unselected Feature. 

The unselected features will NOT be programmed, thus after the 
programming process is completed, the unselected features have 
the same settings as before programming. 

.NOTE: unselecting a feature does not mean deactivating it
Example: if only the Operating Current is selected for 
programming, only the operating current settings is updated 
during programming, all remaining features keep their previous 
values and status.
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ECG Features

The following chapter explains how the ECG features are displayed. Depending on the ECG you use, only specific features will be available. 

Always refer to the ECG's technical documentation for the available features and detailed operating instructions.

:Important notice

Some parameters can be set out of the rated range: In that case, the value is displayed in red. Always refer to the ECG technical 
documentation to understand the consequence of a parameter set out of the rated range.
Some parameters settings are not compatible with others in the same or different features. In case that happens, a warning 
message or symbol is displayed. For example in 2DIM ECGs the LEDset mode is not compatible with Temperature Protection 
Feature.

An error icon is displayed on the respective group boxes with tooltip indicating the cause of error in case the values are out of the 
specified range (e.g.4DIM ECG with a Tuning factor below the minimum value of 50%).
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Operating Mode(s)

The first choice the user has to make is the Operation Mode , i.e. how the ECG shall dim and operate, e.g. MidNight, Power Reduction or 
Mains Voltage Dim for outdoor. There are standard modes (e.g. DALI) and proprietary modes. Which mode is available depends on the 
selected ECG. 
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Operating Current

This feature is used to adjust the output current of the LED driver. Different ways of current settings are possible according to the LED driver 
interface type (LEDset / LEDset2). LEDset2 is a multi-vendor LED module interface which allows to set the correct operating current for the 
LED module by resistor coding, without the necessity to reprogram the constant-current LED driver, if an LED module has to be replaced by 
a newer generation. This ensures optimal efficacy and the right amount of light at all times
Compared to setting the current by using the LEDset2 interface, a higher current accuracy can be achieved by using the fixed current mode, 
and no resistor is necessary on the LED module.

LEDset(1)

For drivers with the LEDset interface (1  generation) the  can be set via this dialog between the st

 and the .
For some LED drivers , the operating currents lower than the  can be set; in this case the  is 
displayed in red color, to highlight that the value is out of the rated range of the driver. 
The check box  enables the LEDset protection behavior. Please consult the LEDset application guide (1  generation) for st

further information.

LEDset2

For drivers with the LEDset2 interface (2  generation) two operation modes can be selected: Fixed Current Mode or LEDset2 Modend

Fixed Current Mode

In the fixed current mode the output current is set to the  value between the  and the 
. In this mode the LEDset2 interface is disabled. 

Some LED drivers allow also a current set lower than the . In this case the  value is displayed in 
red, highlighting it is out of the rated operating range of the LED driver. 
For further information please consult the device specific technical description; for example concerning the allowed operating current range 
and tolerance. 
NOTE: in some LED driver this value defines also the output current "LEDset2 Mode" is selected and a short circuit is applied on LEDset2 
terminals

LEDset2 Mode

In the  the  is defined via the LEDset2 interface and can be adjusted by the  between the 
and  values, if supported by the ECG. This factor can be used to fine-tune the light output for modules with a predefined lumen 
package.

Tuning Factor
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This feature allows to adjust the light level of a luminaire within certain limits (set up by the luminaire manufacturer), which ensure safety, 
lifetime and performance. This feature allows
an adjustment of the amount of light in the field or in production. Thus, one luminaire can manage different lumen packages. 
Also helpful for those cases where people are not familiar with the "current mA" values but prefer to use percentage or lumen value instead 
of mA. In such cases, activate the option "Set Luminaire reference light output at 100%" and enter the appropriate value in lumen. In the 
Configuration Lock, the Tuning Factor Level and the Limits can be protected separately. 

Soft Switch Off

As soon as the device receives a switch-off command by a control interface (e.g. Touch DIM or DALI), this feature dims the device down to 
zero nearly logarithmically, and with pre-defined delay times. This function is supposed to simulate the behavior of traditional halogen lamps. 
If supported by a driver, Soft Switch Off is available when one of the following Operating Modes is selected: "DALI & Enhanced Options", 
"TouchDIM" or "Corridor Functionality". 

This feature can be selected by the Enabled check box. The Soft Switch Off time can be selected from the values in the drop down.
The value 0 indicates feature off and the values 0.7s / 1.0s / 1.4s / 2.0s / 2.8s / 4.0s / 5.7s indicate switch off times.

Dim to Dark

Depending on the driver used, different lowest dimming levels can be achieved. Please refer to the documentation of the used driver for 
specific information. 

 Dimming below 1% enables steady dimming down to the final switch-off of the device. This feature is suitable for Dimming below 1%
theaters, movie theaters or other special applications. For LED drivers with pure amplitude dimming, the minimal dimming value in percent is 
determined by the ratio of minimal output current to rated current. 

 Dimming below 10% allows to reach lower illuminances in the dimmed state. For LED drivers with pure amplitude Dimming below 10%
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dimming, the minimal dimming value in percent is determined by the ratio of minimal output current to rated current. 
Please note that the physical min level (DALI PHY MIN) will be adjusted as soon as the "operating current" is modified or in case of the 
LEDset Mode, after Start-up phase of the device and if the value has changed more than +/-3.1% to the previous one.

OEM Key

This feature enables luminaire manufacturers (OEMs) to safeguard certain predefined setting parameters (e.g. the safety relevant features) 
in the LED driver against unintentional access and not authorized users. The features, that can be protected, are shown in the 

 box.

Some ECGs have also the possibility to lock the ECG completely or only partially. The locked features are listed in the box "Locked Feature
(s):

The locking of these features can be activated by enabling the check box . To lock the ECG a four digits  needs to 
be entered. 
The allowed codes are all numbers in the range 0001-9999 (the Code 0000 is reserved to indicate that the ECG is not locked). In the 
example above the user input the code 1234.
Please note that in new generation drivers, the OEM key has been replaced by the Configuration Lock protection system (see below).
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Configuration Lock

This feature is an advancement of the OEM Key, which allows controlling the access rights for individual features within the LED driver and 
to assign different rights to the luminaire manufacturer, to the service team and to the general user. Assigning user rights also allows offering 
"light as a service" and still maintaining total control over who may change what within the device or luminaire. The Configuration Lock is a 
new multi-level password protection designed to protect drivers against unauthorized changes which could lead to serious safety problems.

By enabling and setting up a Master Key in the driver, the driver can be locked to avoid any changes by anyone that can access the driver. 
Only people that know the Master Key are able to modify the driver settings. In addition, a Service Key can be set up to allow an additional 
user group to modify certain driver settings without having to hand out the Master Key. A Service Key can only be set if there is a Master Key 
available. The Service Key feature requires a  to be activated. There is also the possibility to give write access to everyone.license key

For each key, the user has to enter 4 numbers (and each number can have a value from 0 to 255) to set it up.

The features that can be protected are shown in the 

Driver Guard

By default, the internal safety mechanisms of the LED driver are designed for maximum temperature, however, not for those of the luminaire. 
By means of this feature, you can adjust the temperature derating of the LED driver so that it not only matches the luminaire, but also leads 
to a higher reliability of the luminaire. The thermal performance of an electronic control gear (driver) impacts its lifetime and cost. The LED 
technology creates a demand of flexible driver (window driver) regarding power and operating conditions. In seldom cases, the driver is 
operated at its maximum and therefore the thermal performance is not optimized to the system and application.When enabled, the "Prestart 
Derating" provides an offset to the maximum allowed temperature of the driver.

End Of Life

By means of the connected LED module, the LED driver can visualize that the preprogrammed lifetime of the connected LED module is 
reached and the LED module should be replaced. This feature allows indicating the guaranteed lifespan of the lamp or the whole system in 
case the lamp is not exchanged. The  indication is reference to the lamp operating time. End Of Life
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This feature can be selected by the  check box. 
The end of  range is between 0 and 254kh. The way of indication will differ according to the ECG type. For further information 
please consult the ECG specific technical description.
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Lamp Operating Time

This feature allows to set and reset the .The current value of the lamp operating time is used for the constant lumen 
output function. In case of a lamp replacement the  and also the  function could be reset, if those features are 
supported by the control gear.

The

DALI Settings

In DALI mode, the driver can be controlled by an application controller via the bidirectional DALI interface and it supports status request 
queries. Through the DALI application controller, the driver can be integrated into a light management system. DALI version-1 drivers 
support stepless dimming, status requests, and addressing of each individual light point.

: set the dimming behavior of the output level with respect to the dimming value. 
: set the fade time and rate associated to the related DALI commands. 

Limits
 is the output level set when the mains voltage is supplied to the driver. Power ON Level

 is the output level when DALI line is disconnected or malfunctioning.System Failure Level
 Enables a possibility to reset or keep DALI addresses in case of single ECG programming (default setting = reset). For 

multiple programming all DALI addresses will be reset.
A warning icon on the group box with a tooltip "Cannot keep the DALI address if the programming setup is multiple luminaire" will indicate 
this information when the "Keep existing" option is selected. 

 

 DALI-2
For ECGs that support DALI-2, there is a possibility to select either Standard fade time or Extended fade time. By default standard fade time 
will be selected. By checking the extended fade time checkbox, extended fade time value can be selected. On click of the "Expert mode" 
button, the below dialog is displayed, which will enable the user to select a dedicated base value and a multiplier value and hence sets the 
extended fade time value.



Tuner4TRONIC

Page 30 of 44

 

Note about mismatch in DALI Min Level

According to the DALI standard, a device must not reply a DALI Min Level below the Physical Min Level.
If the DALI min Level has been programmed at a lower level, then a higher Physical Min Level temporary caps the programmed DALI Min 
Level.
The Physical Min Level may be higher if no LEDset resistor is connected and will become lower when the resistor gets connected.  
Thus reading the DALI min level only reflects the momentary state of the driver, but it may change after deploying the driver in the luminaire.
If the DALI Min Level was accidentally set below Physical Min Level, please note that device cannot dim down to the desired level! 
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0-10V Settings

Drivers with a 0-10 V Interface can be integrated into light management systems. This unidirectional interface allows adjusting the light 
output of the system, adjusting the dimming behavior via the 0-10V control port.

: set the dimming level for an input voltage below 1V.
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Thermal Protection

This feature allows to adjust the thermal management of the LED module or of a complete luminaire for high ambient temperatures by 
controlling the output level based on the temperature/resistor value measured at an external sensor (e.g. NTC, negative temperature 
coefficient resistor) connected to the driver. There are two modes for thermal protection:

(not applicable for all control gears with thermal protection feature) 
Either of those can be selected, depending on the control gear type. 

This feature can be switched on by the  check box. 
The desired thermal protection mode, either  or  needs to be selected if supported by the ECG. In 
case of temperature based mode also the  has to be defined. The predefined sensor types are typically used NTCs. sensor type
In  group box the following parameters can be set:Settings

Start Derating
End Derating

 If the control gear supports a complete switch off the shut off point can be defined. In case the  is not enabled the Shut Off:
control gear will not switch off. 
For control gears not supporting a switch off, the S  check box is disabled and not editable.

: This parameter defines the output level at the end derating point until shut off, if supported.Derating Level

Note: The derating level between the start and end derating point could vary to the derating line, which is displayed in the software. 
For further information please consult the device specific technical description.
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CLO

To ensure the maintenance interval of the system, the light level must be achieved also at the end of the entire lifetime. Due to lumen 
depreciation of the light source over time, the system usually needs to be overpowered at the beginning, which leads to increased energy 
cost. This is not necessary thanks to the constant lumen function, as the operating output is adjusted continuously to compensate for the 
lumen loss. A  needs to be created that continuously increases the  of the lamp. Reliable lifetime data of the lamp / LED 
module is necessary for best performance of this function.

This feature can be switched on by the  check box. 
The custom  is defined by the following parameters:schedule

: The value range is between 0 and 254 kh. The values needs to be continuously increasing from the first to last Operating Time
data set

: The value range of the output level is depending on the driver type. The values needs to be continuously increasing Output level
from the first to last data set or at least equal

Depending on the driver type the number of the data sets of the  can vary. The maximum number is 8. For some drivers it is 
necessary to fill in the complete table. 
In the graph the actual lamp operating time is indicated as a vertical dotted line (not applicable for certain gear types) 
By pressing the  button the approximate energy savings is calculated until the last entered operating time value. The result appears Savings
in a separate  dialog box.Energy Saving Potential (Constant Lumen)
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Mains Voltage Dim

This dimming method is mainly used in combination with magnetic ballasts for existing street light installations. The light output is reduced by 
lowering the mains voltage. The reduction of the mains voltage is carried out by a controller in the distribution cabinet. This functionalities 
allow to reproduce this behavior also for electronic control gears.

This feature can be selected by the  feature tab. 
The dimming characteristics can be defined by the following four parameters:

: This parameter defines the start point for derating the output levelStart Voltage
l: This parameter defines the output level until the start point of deratingStart Leve

: This parameter defines the end point for derating the output levelStop Voltage
: This parameter defines the output level after the end point of deratingStop Level

For further information please consult the device specific technical description.
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Power Reduction

The Power Reduction (bi-power) mode allows switching between two output levels, the "normal" mode and the "reduced load" mode, by 
means of an additional switched phase or the control via an external sensor (like presence detection sensor or photocells). In the "reduced 
load" mode, the driver reduces the lighting level and therefore the energy consumption. The light levels can be preprogrammed flexibly.). In 
the  feature tab the option , inverse (polarity of the signal) or Autodetect needs to be Power reduction Power reduction 
chosen. The selected mode is shown in the Dimming Mode group box.

This feature can be selected by the .
The dimming characteristics can be defined by the following six parameters:

 This parameter defines the output level when the SD port is not triggered.(Power reduction) / Nominal Level/(Power on Level):
triggered (  inverse)Power reduction

 This parameter defines the l when the SD port is triggered. ( ) / not triggered (SD Level/(Dim Level 1): Power reduction Po
inverse)wer reduction 
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 This parameter allows the adjustment of the  at power on (not applicable for certain gear types)Switch on Fade Time:
: This parameter defines the  after the SD port is triggered ( )/notStart Fade Time/(DIM Fade Time) Power reduction

triggered ( inverse) (not applicable for certain gear types)Power reduction 
: This parameter defines the  after the SD port is not triggered ( )/triggered (Hold Time Power reduction Power reduction

inverse) (not applicable for certain gear types)
: This parameter defines the  after the hold period (not applicable for certain gear types).End Fade Time/(DIM Fade Time)

For further information, please consult the device's specific technical description.
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MidNight

This feature provides multi-stage night-time power reduction based on an internal timer referenced to the power ON/OFF time. There is no 
need for an external control infrastructure. The unit automatically performs a dimming profile based on the prede fined scheduled reference 
to the midpoint, which is calculated based on the power ON/OFF times. Two modes are available:

 (not applicable for certain gear types)Time Based :

If the  is selected the dimming profile can be adjusted in the  based on the switch on point of the 
mains.
In this mode the  is not selectable.

Astro Based:

In this mode the dimming profile is executed referenced to the half operating on time of the driver. It is assumed that there is a correlation 
between the half operating on time (virtual middle of the night) and midnight, expressed by the midnight shift. 

The virtual middle of the night is calculated based on the theoretical sunset (Power on) sunrise (Power off) and the  depending on 
the selected . It is assumed that the driver is powered-on at the theoretical sunset and powered-off at the theoretical sunrise. The 
average annual midnight shift is used to convert the time steps of the reference scheduler to time values reference to the half one time. 
Certain predefined locations can be selected by the  drop down menu and also custom locations can be defined by clicking on the 

. In the  the output level as well as the time for each dimming step can be given for up to five dimming world symbol
levels (steps). 
When working with Locations, please make sure to select a location from the menu first and then edit the Reference Schedule. Working the 
other way around (first editing the Reference Schedule and then a Location) will reset the parameters of the Reference Schedule.
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The  group shows the dimming profile for a specific day, when  is selected. The values are only valid within Schedule
a certain tolerance, if the driver is powered on at the time step1 and powered off at time step 6 at this date. 
Some countries use the daylight saving time. If this needs to be considered in the visualization of the graph and the schedule, the check box 

 needs to be enabled. Note that the control gear cannot compensate the time shift related to the daylight saving time.
In addition it is possible to enter custom switch on and off times by selecting the  option.

Note:  If switch on and off times are entered manually, these values are only used to calculate the estimated dimming behavior of the 
ECG if it is powered on/off at these times. The device does not switch on and off by itself.

The  information is only visible in  mode. The approximate energy savings will be indicated with the assumption Energy savings
that the real switch on and off time match with the calculated sunset and sunrise times. The result is shown in a separate Energy Saving 

 dialog box.Potential (MidNight)
The fade time characteristics can be defined by the following three parameters:

 This parameter defines the  at power on. (not applicable for certain gear types)Switch on Fade Time:
: This parameter defines the  between the different output levels. There are different Astro Fade Time / (DIM Fade Time)

ranges and levels allowed for the various types of control gear.
 This parameter defines the fade time for the switch off. (not applicable for certain gear types)Switch off Fade Time:

Depending on the selected control gear the available parameters will appear as active. For further information please consult the device 
specific technical description.

Note: When switching between  and  or vice versa the Reference Schedule will be set to default.Time Based Astro Based

SD triggered:
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In this mode, the start of the dimming profile is triggered by the SD Port (Half night Switch). This ensures that the luminaires can be dimmed 
at the same time triggered by an external clock timer using the SD interface and are not affected by the time shift during the year in the 
standard "MidNight based" feature.
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Presence Detection

In the MidNight mode, this feature allows to adjust the output light level to the activity around each light point with an additional external 
sensor connected to the SD port and powered by the mains, regardless of the actual dimming level of the MidNight mode. The presence 
detection profile has a higher priority than the output level defined by another dimming mode during presence detection (except for DALI).

This feature could be selected by the  feature .
The dimming profile can be defined by the following four parameters:

 This parameter defines the  when the SD port is triggered.PD Level:
: This parameter defines the  after the SD port is triggeredStart Fade Time

: This parameter defines the  after the SD port is deactivatedHold Time
: This parameter defines the  after the hold periodEnd Fade Time

For further information please consult the device specific technical description.
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Emergency Mode

In addition to DALI-compliant functions, such as system failure level (disconnecting the control line), DALI LED drivers with this feature offer 
the automatic detection of DC voltage supply. When DC voltage is detected, a preprogrammed luminous flux level between 0 and 100 % is 
implemented. Typically, the factory setting for indoor LED drivers is 15 %. This luminous flux value can be additionally protected from 
unintentional overwriting by setting a locking bit.

: enables the driver to activate the Emergency operation when a DC supply voltage is detected and 
consequently switches to the related .Output Level
Refer to the driver's technical documentation to see which further features are affected by the Emergency operation. 

:
: enable this option to avoid that the Output Level (input in the DC mains -> Emergency Mode field) is changed in Lock DC Light Level

application by the DALI controller.
 enable this options avoid that any standard DALI parameter could be changed by a controller during DC operation.Lock DALI Parameter:

A warning icon on the group box shows the tooltip: "Locked DALI parameters may cause problems with control devices.".

Note: ECGs which have this feature setting capability are not always compliant by default for emergency application. The functionality 
could be limited for pure DC grid environment. Please consult the ECG specific technical description.

Lamp and Energy Saving

: for Quicktronic ECGs, select the lamp type here. 
: for Quicktronic drivers, enable this option to perform the burn-in process of the fluorescent lamps. The duration of the burn-

in process is defined by the  field. Burn in Time
Refer to the driver's technical documentation for further details.
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Luminaire Info

power, lumen, expected lifetime, etc.
This data can be stored in the luminaire's driver and can be read by Light Management Systems (LMS) to simplify the comissioning of the 
luminaire as well as for service purposes.

for predictive maintenance.
To activate Luminaire Info, a  is required.license key

This feature is deactivated by default to avoid longer programming times if the feature is not used. To activate it please make sure to activate 
the corresponding checkbox on the feature list.

In additon, each parameter of the Luminaire info can be activated individually. Please deactivate the parameters that are not needed by 
deactivating the corresponding checkboxes to optimize the programming times.
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Monitoring Data

Monitoring Data is a new mode in Tuner4TRONIC that allows to read the operational data of a driver e.g. operating times, power, voltage, 
temperatures, failures.
These parameters stored in the luminaire's driver can be used for service/diagnostic purposes, for predictive maintenance and to feed a 

Only drivers supporting Monitoring Data can show this mode. Monitoring Data can be found as a new tab between the Features and 
Summary tabs.

To start, click the "Read from ECG" Button on the upper left part of the screen. If the driver was locked you will need to enter the driver's 
password to continue.
After reading the device, T4T will show the devices unique serial number as well as the available parameters.

On the upper left corner, it is possible to toggle the display of the parameters from dashboard view to table view.

The automatic log function allows to enter a time value, after which the data will be refreshed automatically. 
In addition, the parameters can be exported as a CSV file. The unique serial number of the device will be used as the file name.

Please note: Reading the Monitoring Data of a driver using the NFC interface will not show all parameters in comparison as using the DALI 
interface, as some parameters are not available when reading through NFC (e.g. power).

While the basic set of parameters is always displayed, the premium parameter set requires a  to be displayed.license key

 As far as features of the Tuner4TRONIC-Tool are used to readout data of LED drivers, the provided data has the usual Disclaimer:
limitations regarding accuracy and reliability due to technical reasons based on the current state of art and technology and is only meant as 
clue and aid for diagnostic purposes. Therefore, the manufacturer of the software and the driver shall not be liable for the accuracy and 
reliability of the provided results including any incorrect data or their incorrect technical interpretation due to the current state of technology
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License Key(s)

To activate certain additional functionalities in Tuner4TRONIC it is necessary to introduce a license key, e.g.

Monitoring Data - Premium parameters+
Luminaire Info
Tunable White - Premium parameters
Service Key in Configuration Lock

The license key management can be found in the menu Help  About  License Key(s).

In that window, the unique machine ID of the computer will be displayed. 
When ordering a license it is necessary to copy this machine ID by clicking on the "Copy to clipboard" button and send it to your sales 
contact,. A license key specifically designed for that machine ID (i.e. the license can't be used on another computer) will be generated.
Entering the license into the "License Key" field and clicking the "Add Key" button will activate the license and the corresponding feature will 
be available for use in Tuner4TRONIC.

All entered licenses are displayed in the list below together with their expiration date.

Please contact your sales representative to obtain licenses.


